Volunteer Scheduler Pro

Quick Start Guide – Salvation Army
Introduction
Welcome to Volunteer Scheduler Pro! This Quick Start Guide was created specifically with the
Salvation Army and Kettle Campaigns in mind, and will guide you through the process of creating
schedules, publishing opportunities and filling shifts in just a few easy steps. We recommend that you
print this guide by choosing “Print…” from the File menu and read it while getting started with VSP.

Step 1: Defining your database
When you launch VSP, it’s helpful to re-label the headings on the left-hand side to more accurately
reflect Kettle Campaign schedules. We will use the Jobs pane to manage the locations of your kettles.
Click the “Edit” menu at the top of the VSP window, and select “Change label used for ‘Job.’” Change
the word “Job” to “Kettle” (enter the singular form of the word and VSP will pluralize as needed).

Step 2: Setting up your kettles
Specify the kettle locations where volunteers will be serving. Later on you will be able to specify how
many volunteers should be scheduled at each kettle location.
To create a kettle location, first click on the Kettles
pane on the left hand side of VSP’s main screen
(the screen which appears when you launch the
program). Then click the “New Kettle…” button. In
the dialog that appears enter a name for the new
kettle (e.g. “South Mall”, “Library”, etc.).
To ensure all volunteers can easily sign up for any
location, check the option that says, “Qualify new
volunteers for this kettle location by default.” There
are several other options available that affect how
positions appear and are scheduled. These options
are not discussed in this Quick Start Guide, but you
may click on them inside VSP to see a short
explanation of what each option does.
For the purposes of getting started with VSP, just enter the name of the kettle location in the “Name”
field, and then click OK. Then click the “New Kettle...” button again to repeat this process for each
kettle location you will be scheduling.

Step 3: Creating a schedule and shifts
After you've entered all your kettle locations, click on the Schedules pane on the left hand side of VSP's
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main screen and enter the start and end dates for a schedule. Clicking the calendar icons to the right of
the date fields will produce calendars from which you can select the dates. After you have entered your
schedule’s start and end date, click the “Create…” button. A window will open that contains a blank
schedule spanning the date range you specified.
Now you'll want to create your shifts:
1) Click on a day in the calendar on which one of your shifts take
place.
2) At the top of the schedule window, click the “New Shift...”
button.
3) In the dialog that appears, set the start and end time for the shift
by clicking on the hours or minutes and typing in the correct
value – or by using the arrows next to each value.
4) If the shift repeats on other days of the week, click the dropdown for “Repeats” and then click on the days of the week.
(The other instances of this shift will automatically be created
for you, both in this schedule and in your future schedules.)
5) Next, specify how many volunteers are required at each kettle
location for this shift. Select a kettle from the list by clicking
on it and then type the number of required volunteers for that
location. (You can also use the arrows that appear below the kettle location list to adjust this
number.)
6) Once you have configured this shift for the correct times, days, and required volunteers for each
kettle location, click OK. Then repeat this process for all your other shifts.
When you have finished creating all your shifts, choose “Save” from the File menu at the top of the
schedule window. A dialog will open asking you to enter a name for the schedule. Be sure the box is
checked to “Make this schedule live now” and select the option to “Just use the default layout and
options for now,” and then click OK.

Step 4: Entering your volunteers
Now that the schedule is saved, it’s time to get your volunteers into the database. There are three ways
to do so:
1. Import existing volunteers’ contact information from a .csv (Excel) or .txt file. For help
importing volunteers, please refer this article in VSP’s Complete Documentation.
2. Email your organization’s enrollment form to a list of contacts. As people enroll, they are
added as a volunteer to the database and can sign up for shifts at the same time. See below for
more information.
3. Enter your volunteers’ information manually one volunteer at a time. See the section below
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for information on manually entering volunteers.
Using the Enrollment Form
VSP’s enrollment form is an online form that potential volunteers can use to both register their personal
contact information to be added to your database, and sign up for open positions. To see the enrollment
form, click on the Web Terminal pane on the left hand side of VSP's main screen. At the top of the
pane, click “Web Terminal Settings” and then click the Enrollments pane on the left. The Enrollment
URL at the top is the direct link to your form, which you can send to volunteers.
For more information on customizing enrollment forms, please refer to this section of the
documentation. There is also a video tutorial on the topic. Enrollment forms are a great way to invite
volunteers to sign themselves up.
Manually entering volunteers
Click on the Volunteers pane on Volunteer
Scheduler Pro’s main screen and then click the
“New Volunteer…” button for each volunteer
you are scheduling. Enter the first and last
name of the new volunteer, and add his or her
email and contact information. You can create
and enter values for custom fields by clicking
the “Edit custom fields...” button. By default
all volunteers will be qualified in all kettle
locations.
The rest of the settings on the right hand side
of the dialog are used to track volunteer
availability and preferences. You will not need
to use these sections if you are primarily
having volunteers sign up for shifts online.
You will only need to use the “Shift
preferences” and “Preferred serving frequency” sections if you are using the auto-scheduler.
When you are finished editing this volunteer’s profile click the OK button. (For a detailed explanation
of all the options available in the Edit Volunteer dialog, refer to VSP's Complete Documentation.)

Step 5: Scheduling volunteers
Once you have created your schedule and imported/entered volunteers, you are ready to start
scheduling volunteers. (Note: if using Enrollment forms, volunteers may have already signed up for
shifts and you may skip this step).
There are two common methods used to schedule Kettle Campaigns:
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1. Volunteers sign up for shifts online
2. You manually add volunteers to particular shifts
Volunteers sign up for shifts online
To see how volunteers will sign up for shifts online, click on the Web Terminal pane on the left hand
side of VSP's main screen, and click the “Login as...” button. Choose a volunteer to login to the Web
Terminal as if you were that person. Once you are logged in, click on the “Full Schedules” tab at the
top of the page, and then click on an unfilled position to sign up for a shift. Once you submit the
request, go back into VSP (minimize or close the web browser window), and click on the Web Forms
pane on the left hand side of VSP's main screen. You'll see an “Assignment form” in the list that
represents the assignment request you submitted online. To actually make the assignment in the
schedule, select the form and click the Process Form button. (You can also set up these forms to be
automatically processed, so the assignments are made in real time as soon as the forms are submitted.)
When you are ready to introduce VSP to your volunteers:
1) Go to the Announcements pane on the left side of the program window.
2) Click on the “Templates” button at the top of the window, select “Preconfigured” and from
there select, “Introductory email – schedule finalized” and click “Use.”
3) We recommended adjusting this template for the Salvation Army. Because we are asking
volunteers to sign up, read through and adjust the intro paragraph accordingly. We do want to
leave the WebTerminal tokens, as these will provide volunteers with their usernames and
passwords to login; they are like mail-merge fields and will populate automatically.
Here we have modified the template to work best for Kettle Scheduling needs, which you may
copy and paste into VSP (using the Edit menu at the top of the VSP window):
Dear {{FullName}},
We are pleased to announce that we are putting into place a new system that will make
scheduling much easier for everyone! Using this online system you'll be able to sign up for
positions online. You'll also be able to check your schedule from anywhere and easily find a
substitute when you can't make one of your scheduled dates. For information and help on how
to use this system, please watch this short video.
After watching the video, you can log in to the "Web Terminal" using the link below, and from
the Full Schedules tab begin signing up for shifts:
{{WebTerminalHomePageLink}}
Username: {{WebTerminalUsername}}
Password: {{WebTerminalPassword}}
If you have an iOS or Android device, you can download a free app that will make it easier to
view your scheduled dates or request and accept subs from your mobile device! Follow these
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steps to get started:
1. Go to the App Store or Play Store on your device and download the "Volunteer Scheduler
Pro" app.
2. Open the app and enter the following under Organization ID:
{{OrganizationWebIdentifier}}
3. Enter your Web Terminal Username and Password to log in.
If you have any questions just email me by clicking the reply button. Thank you so much for
your help!
4) Review the subject line, and then click the “Preview” button. Click OK in the token options
window that will appear. In the list of names that appears on the right, click on a name once to
preview how the email will look for that individual.
5) When ready, click the “Send” button to send this as an email, and volunteers can begin signing
up for shifts.
6) For any volunteers without internet access, use “Print” in the drop-down menu to the right of
the sent email and choose “Copies for those without internet access.” These volunteers may
continue to reach out over the phone, in person, or whichever method they have been most
comfortable with, and as the scheduler you can manually place them or adjust assignments. See
the next section for help with manually scheduling volunteers.
Manually schedule volunteers
Open the saved schedule you created by clicking on the Schedules pane on the left hand side of VSP's
main screen, selecting the schedule, and then clicking the “Open Schedule” button. Then click on a day
in the calendar view that contains a shift. Click on one of the empty positions in the shift and you'll see
that the volunteer list on the right side of the window shows the volunteers that are eligible and
available to fill the selected position. VSP displays volunteers with scheduling conflicts in red and
orange. For example, if a volunteer is already scheduled at that shift, his name will appear red to warn
you not to schedule him in the selected position. To fill the position with one of the volunteers in the
list, double click or drag and drop the volunteer to assign them.

Step 6: Setting up the Web Terminal
As volunteers sign up for positions online, these changes will appear inside of VSP as web forms. To
allow assignments and enrollment forms to process in real time, it is recommended you turn on the
automatic processing option for web forms:
1) Go to the Web Terminal pane in VSP, and click the “Web Terminal Settings…” button at the
top.
2) In the Settings window that opens, click on Enrollments on the left. To process new volunteers
and their assignments automatically, check the option for “Automatically process enrollment
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forms.”
3) From the same window, click on Assignments on the left, and check a similar “Automatically
process assignment forms” to absorb self-sign up’s in real time.
4) Click on the Swap Requests heading on the left, and check the “Automatically process swap
requests” option here to process these in real time as well. A pop-up will confirm if you would
also like Swap Accepts to be automatic – select “Yes.”
5) Click OK in the Settings window, and then click the Commit Changes button to save these
changes.
Auto Reminders
You can configure VSP to send automatic email to volunteers before they are scheduled to serve:
1) Go to the Web Terminal pane in VSP, and click the “Web Terminal Settings…” button at the
top.
2) In the Settings window that opens, click on Auto Reminders on the left.
3) Check the box “Send automatic email reminders.” and optionally click on the number of days to
adjust how early a reminder email is sent.
4) Where the subject line for the reminder appears, feel free to customize, and click the “Edit
Email Body…” button to customize the reminder email that is sent out. (Note: the tokens in this
email affect the deliverability of the mail, and we recommend adjusting the text around the
tokens only.)
Customizing the Web Terminal
The text we see inside of the program, when we click on the Web Terminal pane on the left, is the same
volunteers will see when they login. First it is a good idea to use the “Login As..” button at the bottom,
pick any name and login as someone (if you have manually entered any volunteers). This will take you
to the login page so you may see the Web Terminal from a volunteer’s perspective.
Within the program, from the Web Terminal pane click on any of the text in the tabs to change and
customize for your organization.

Conclusion
You’ve just seen how easy it is to create schedules, publish opportunities and fill shifts using Volunteer
Scheduler Pro. The program also contains hundreds of other features that were not covered in depth in
this Quick Start Guide. Highlights include VSP’s Annoucements, hours scheduled reporting, attendance
tracking, text message blasts, and more. For an inventory and explanation all of VSP's features please
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refer to the complete documentation. Please do not hesitate to contact us as questions arise. We are
happy to help you get started with VSP and make sure that all your Ministry Unit’s scheduling needs
are met.
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